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3D-rone App UT plan

App Description

The 3D-rone App is an interactive 3D web-based application that enables 3D visualization of
indoor drone flight operations for inspection of large buildings. In this experiment we want to
test if any App Participants can understand Critical Operational Steps for Building Inspection
from Expert Participants.

Purpose

The usability test of the 3D-rone will be conducted using zoom and our purpose is to discover
any usability problem in using the App. More details on the planned 8 sessions and zoom links
to attend them can be found on the consultant website here.

Method

In this study the Administrator, Josiane Isingizwe, is referred to as Experimenter 1 and the two
Developers in each of the planned sessions will be referred to as Experimenter 2 and
Experimenter 3.

Using a computer monitor and mouse-and-keyboard participants will explore the designed
visualization. At the beginning of the test, participants will be asked to fill out two forms:
consent form and demographic survey. Then, the second part will include explaining the use of
the App through a test scenario and tutorial video. Third, a think-aloud semi-structured
interview will follow in which a set of task performance questions are established for
participants to perform within the visualization. The experimenters will read semi-structured
task performance questions listed below one by one for participants and the participants’ task
will be to find an answer in the App and respond to the questions verbally, describing their
mental process to achieve those tasks. The conversation will be recorded for later processing.
After participants are done culminating the activities, a link to the final survey will be shared to
participants by the Experimenters to measure participants' visualization, design usability, and
their situational awareness during the tasks.

Test setup

The following steps will be followed during the test:

1. Greeting and introduction of the three experimenters to the participants.
2. Reading and signing the consent form and the demographic survey
3. App demonstration using Help and test scenario
4. A think-aloud semi-structured interview asking task performance questions
5. Final Survey and debriefing
6. Thanking the participants for participating.

Test scenarios

Test Scenario 1

http://www.csl.mtu.edu/classes/cs4760/www/projects/s22/grad1/www/Usability_Test_Schedule.pdf
https://docs.google.com/forms/d/e/1FAIpQLSdbnc37bVAtwNEiIOIkii-NbJIz7pJKG9ixr0xqm6P6tr-VVg/viewform?usp=sf_link
https://docs.google.com/forms/d/e/1FAIpQLSd5GG1IY5nfLy3ZMXIAEdRocrfrWF-Uw9OfuDkDXDYh3t27TQ/viewform?usp=sf_link
https://docs.google.com/forms/d/e/1FAIpQLSfF4B1ErSQWQwQag3pUSKWRNLkzquOmc5v6nBFGMNskoX8DQA/viewform?usp=sf_link
https://docs.google.com/forms/d/e/1FAIpQLSdbnc37bVAtwNEiIOIkii-NbJIz7pJKG9ixr0xqm6P6tr-VVg/viewform?usp=sf_link


3D-rone App UT plan

You have just been hired by a construction company that uses drones to inspect large buildings.
Your supervisor gives you access to the company’s desktop computer which has the 3D-rone
App. You are asked to use the App and learn how expert drone pilots fly drones indoors when
inspecting large buildings. You have never used a drone for building inspection before.

Your supervisor gives you the following instructions:

(1) Use Defaults in both the Upload tab and Align Tab

(2) Focus on the Analyze Tab, and use the Help Tab if you have any questions.

(3) inspect the markers located at the red dots in the building

(4) make sure you understand the operations of flight 1 taken by pilot 4, as you will be
following that path to inspect the same building next week.

Your taks:

1. Visualize at least one drone flight done by pilot 4.
2. Find out the order and names of each inspection point in the path.
3. To understand the drone direction, move the drone closer to one of the inspection points.
4. Take at least two screenshots to show me you were able to figure out how to do it..

Test Scenario 2

You are an experienced drone pilot and you just got a job to inspect an office building in
Hancock. As you have never flown the drone in such a large building, you decide to reach out to
a friend for help. Your friend recommended that you use the 3D-rone App to be able to visualize
drone flights in large building interiors and learn from previous drone pilots who performed
similar tasks in the past. Your goal is to identify the pilot approach you will follow to
accomplish your goal.

Your friend shared the following tips to get started with using the 3D-rone App:

1. Upload data in the App and remember to Align scenes with data points.
2. In the Analyze Tab, explore the App viewer, Drone Data, Mouse Data, and Path Toggle

to understand how the App works.
3. Visualize the building interiors carefully using the mouse and identify which pilot

approach you will follow to accomplish your goal.

You opened the App and keeping in mind your friends’ advice you choose to perform the
following tasks:

1. Explore all main features in the App: Upload, Align, Analyze, Help.
2. Use Defaults data in the Upload Tab and Align Tab.
3. In the Analyze Tab:

● Visualize the flights shown in the viewer by pressing the play button in the
viewer window.

https://2021-sd-ui.github.io/1/
https://2021-sd-ui.github.io/1/
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● Pause the visualization in the viewer then make a record of the drone location,
rotation, and velocity in the Drone Data section.

● Check the mouse data then, move to the Path Toggle and unclutter the view by
turning all drone flights invisible except the one highlighted in the Path Toggle.

● Visualize two drone flights taken by at least two pilots, and observe the
differences or similarities in their approach.

● Close the App when feeling confident to achieve your goal.

Test Observations

1. Participant's screen as they perform the task and any App errors while using the App.
2. The process each participant takes to complete each task when navigating the App.

Test Measurements

1. The time it takes each participant to complete each task.
2. Total amount of time the whole study takes to complete.
3. App Usability, difficulties, approaches through semi-structured interviews and surveys.

Test surveys and questions

1. Consent Form: here

Computer User Interface Usability Testing                                             App Name: 3D-rone App

You are being invited to participate in a research study to determine the usefulness and usability
of computer user interfaces. This study is being conducted by Dr. Robert Pastel of Michigan
Technological University Computer Science Department and Dr. Pastel's Human-Computer
Interaction (HCI) courses. The students are performing the usability tests as part of their project
and to fulfill the HCI course requirements.

There are no known risks if you decide to participate in this research study. There are no costs to
you for participating in the study. The information you and the tasks that you will perform will
determine the usefulness and usability of user interfaces. The questionnaires and the tasks
should take less than an hour to complete. The information collected may not benefit you
directly, but the information learned in this study should provide more general benefits.

The questionnaires and tests are anonymous. No one will be able to identify you and your
answers, and no one will know whether or not you participated in the study except for the
instructor of the class who is giving you credit for participating. Should the data be published,
no individual information will be disclosed.

Your participation in this study is voluntary. By completing the questionnaires and performing
the tasks, you are voluntarily agreeing to participate. You are free to decline to answer any
particular question you do not wish to answer or not to perform a task for any reason.

The testing may make use of video conferencing software which will record your tasks on the
computer screen and from your webcam. The webcam recordings will not be shared, and you

https://docs.google.com/forms/d/e/1FAIpQLSdbnc37bVAtwNEiIOIkii-NbJIz7pJKG9ixr0xqm6P6tr-VVg/viewform?usp=sf_link
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may mute the webcam at any time. Before sharing your screen, you should clear your desktop
of any open apps except your browser. Also you should clear your desktop of any icons or
widget that you wish not to be observed.

If you have any questions about the study, please contact Dr. Robert Pastel, Associate Professor,
Computer Science Department, Michigan Technology University, Houghton, MI 49931.

2. Demographic survey: here

Q1. Do you identify with any of the following terms:

☐ Male  ☐ Female ☐ Other: __________ (feel free to skip this question)

Q2. What is your age: ________________ years (feel free to skip this question)

Q3. What is your field of study? Please include your major and/or minor if possible

___________________________________________________________________

Q4. What is your educational level?

□ Freshman □ Sophomore □ Junior □ Senior □ Other (please specify)

Q5. How many years of professional experience do you have in building inspection?

□ No experience □ Less than 6 months □ 6 months to 1 year □ 1 to 2 years □ Over 2 years

Q6. How would you rate your experience in using drones?

□ Beginner □Advanced beginner □ Competent but not an expert □ Almost an expert □ Expert

Q7. Do you have any experience in using 3D Applications? (Please specify if possible)

___________________________________________________________________

3. Semi-Structured Interview Task Performance questions: also available here

Q1: “How many drone pilots are present in the data shown to you?”

Q2: “How many flights per pilot are shown in the visualization?

Q3: “How many inspection points are in the App?”

Q4: “Considering the flight route taken by pilot 4 in flight 2 from the first inspected target to the
last one, does pilot 4 have a preference for target exploration direction (i.e., clockwise,
counterclockwise)?”

Q5: “Does the drone camera for Pilot 4 face every target at some point in the flight 2 path?”

https://docs.google.com/forms/d/e/1FAIpQLSd5GG1IY5nfLy3ZMXIAEdRocrfrWF-Uw9OfuDkDXDYh3t27TQ/viewform?usp=sf_link
http://www.csl.mtu.edu/classes/cs4760/www/projects/s22/grad1/www/JI_Usability_Test_Instructions.pdf
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Q6: “Did Pilot 4 in flight 2 use the same speed when inspecting every inspection target?

Q7: “After visualizing the flight route taken by pilot 4 in flight 2, in your opinion which
building inspection targets were the most difficult to observe and why?”

Q8: “After visualizing the flight route taken by pilot 4 in flight 2, in your opinion which
building inspection targets were the easiest to observe and why?”

Q9: “Which building inspection target was the last inspected by pilot 4 in flight 2?”

Q10: “Which drone pilot performed the building inspection task the fastest?”

open ended questions

Q1: “Overall, was it easy or difficult to understand how to perform the tasks during this study?
Please elaborate your answer.”

Q2: “What task did you enjoy the most during this study”?

Q3: “What task did you find frustrating during this study”?

Q4: “Do you think this App is a useful tool for novice pilots who want to learn critical
operational steps for indoor building inspection from Expert drone pilots? Please elaborate your
answer.”

4. Post-test survey: here

Q1. I think that I would recommend drone pilots to use this 3D-rone App frequently

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q2. I found the 3D-rone App unnecessarily complex

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q3. I thought the App was easy to use

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q4. I think that I would need the support of a technical person to be able to use this App

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q5. I found the various functions in this App were well integrated

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

https://docs.google.com/forms/d/e/1FAIpQLSfF4B1ErSQWQwQag3pUSKWRNLkzquOmc5v6nBFGMNskoX8DQA/viewform?usp=sf_link
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Q6. I thought there was too much inconsistency in this App

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q7. I would imagine that most people would learn to use this App very quickly

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q8. I found the 3D-rone App very cumbersome to use

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q9. I felt very confident using the 3D-rone App

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q10. I needed to learn a lot of things before I could get going with this App

□ Strongly Disagree □ Disagree □ Neutral □ Agree □ Strongly Agree

Q11. Please provide any final thought about your experience using the 3D-rone App

___________________________________________________________________
__________________________________________________________________


